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DIGITALE LEEROMGEVING

Bij sommige opdrachten heb je hulpmiddelen nodig. Bijvoorbeeld filmpjes, formulieren of een link naar een

website. Deze staan allemaal in de digitale leeromgeving. Dit icoontje verwijst naar de digitale
leeromgeving. Om hier te komen ga je naar digitaal.boomonderwijs.nl/beroepsonderwijs.

Eerste keer inloggen in de digitale omgeving

Voordat je de digitale leeromgeving kunt gebruiken moet je je licentie activeren.
e Overleg met je docent welk type account je gebruikt.

e Ga naar www.boomberoepsonderwijs.nl/licentie.

e Bekijk de instructiefilm of lees het stappenplan.

e Volg de stappen.

Daarna kun je aan de slag!

WAT IS UNITY?
Unity is een platform waar game-developers spellen op kunnen ontwikkelen. Unity heeft een laag instapniveau
en biedt veel ondersteuning tijdens het ontwikkelen van een spel.

Qunity

In Omgaan met Unity worden verschillende functionaliteiten van Unity uitgelegd en is er een eindopdracht
waarin alles wordt samengevoegd tot €én spel. Zo leer je niet alleen de theorie, maar leer je ook daadwerkelijk
werken met Unity.

Elk hoofdstuk bevat:

e visuele en tekstuele uitleg

e opdrachten over de specifieke functionaliteit

e voorbeelden en tips over het gebruik van de functionaliteit
o testjezelf-vragen over de theorie.

Let op!

De nummering die in de video's wordt gebruikt komt niet altijd overeen met het nummer van het hoofdstuk.
Volg de videolessen in volgorde van het aangeboden materiaal.

Video-uitleg

Bekijk de introductievideo.




LEERDOELEN

Je leert:

1.  Unity te installeren

2. bewegingen te creéren in Unity

3. levels te bouwen in Unity

4. kleur en textuur aan te brengen in Unity

5. geluid te gebruiken om sfeer te bereiken in Unity
6. physics te gebruiken in Unity

7. user interfaces (Ul) toe te passen in Unity

8. particle effects toe te passen in Unity

9. licht te gebruiken in Unity en dat te renderen

10. een spel te maken in Unity.

WAT IS UNITY?



2 INTRODUCTIE UNITY

In dit hoofdstuk ga je Unity installeren en krijg je uitleg over hoe je Unity moet gebruiken.

Video-uitleg
Bekijk de video over het gebruik van Unity.

(ol DLV ) NI Unity installeren

Eerst gaan we Unity downloaden:

e Bekijk de video die het downloaden uitlegt.

e Download Unity Hub.

e Voer de installatie uit.

¢ Volg de stappen om de installatie te voltooien.

THEORIEBRON UNITY PROJECTS

Unity werkt met Projects. Projects zijn folders waar al de informatie van jouw game in zal staan. Deze projects
kunnen verschillende opties hebben; 2D, 3D, 3D With Extras, High Definition Render Pipline (RP) en Lightweight
RP.

2D en 3D bieden dezelfde functionaliteit, het enige verschil is dat de camera op 2D of 3D staat.

3D With Extras biedt extra rendering (verwerken van beelden) en post-processing (na
bewerking)-mogelijkheden. Dit is handig wanneer je een meer realistischer game wilt gaan maken, maar
het is niet makkelijk om met deze extra’s te werken omdat er aangenomen wordt dat de gebruiker ervaring
heeft met deze opties.

De andere twee opties hebben ook met rendering en post processing te maken en bieden ieder extra
ondersteuning hiervoor.




INTRODUCTIE UNITY

oL o\ 3D-project aanmaken

Start Unity op en maak een 3D-project aan door op de blauwe knop NEW te drukken. Geef je project een
naam en kies de locatie waar je deze wilt opslaan. Klik op CREATE.

Templates Settings

New Unity Project
v'

2D 3D 3D With Extras

HH
-

Location *

D:\unity projects

High Definition LWRP Template
RP

Maken van een project.

THEORIEBRON DE SCENE EN HIERARCHY

Nadat het project gemaakt is zal Unity deze laden. Wanneer Unity een nieuw project laadt, zal er altijd een
lege Scene gemaakt worden met een Main Camera en een Directional Light. Unity werkt dan ook met Scenes.
Scenes bevatten alle spullen die in de game zitten. Dit zijn dus alle aspecten die een game bevat, zoals geluid,
licht en objecten.

Standaard scene.

De standaard scene bevat al een camera en licht, maar is verder leeg.

Links van het Scene-scherm zie je de Hierarchy. De Hierarchy bevat alle objecten die een Scene bevat. Vanuit
de Hierarchy kan je nieuwe objecten in de Scene plaatsen, verwijderen en aanpassen.



INTRODUCTIE UNITY

l Create 'I (arAll )

-

Create Empty |
Create Empty Child I
3D Object > Cube
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul > Text - TextMeshPro
Camera Ragdoll...
Terrain
Tree
Wind Zone
3D Text

Een nieuw object creéren vanuit de Hierarchy.

GameObjects in de Scene

Plaats GameObijects in de Scene. Je kan dit doen door met de rechtermuisknop in de Hierarchy te klikken,
of op het knopje Create te drukken in de linkerbovenhoek van de Hierarchy.

a. Maak een Cube.
b. Maak een Sphere.
c. Maak een Capsule.

d. Maak een Cylinder.

THEORIEBRON 3D-OBJECTEN

Er zijn verschillende 3D-objecten waar je uit kunt kiezen: Cube, Sphere, Capsule en Cylinder. Dit zijn
3D-vormen.

Maar er zijn meer 3D-objectopties en die bieden andere mogelijkheden:

e EenPlaneis een platvierkant dat vaak gebruikt wordt als een platform waar de speler op loopt. Een Plane
heeft geen onderkant, wat betekent dat je de Plane niet van onderen kan zien.

¢ De Quad-optie wordt gebruikt om afbeeldingen te laten zien. Quads zijn net als de Plane plat, maar in
plaats van horizontaal is een Quad verticaal.



INTRODUCTIE UNITY

e Terrain is ook een echte 3D-optie. Unity biedt een uitgebreide selectie om met Terrains te werken. Er
kunnen bergen gemaakt worden, ook kan het Terrain verschillende kleuren hebben en er kunnen zelfs
gras, bomen en andere objecten op het Terrain gezet worden. Met de optie Tree is het mogelijk om
bomen te maken. Deze bomen kunnen tak voor tak opgebouwd worden en zijn dus zeer uniek.

Wanneer de 3D-objecten geplaatst zijn, zul je deze in het Scene-scherm kunnen zien. Alle geplaatste objecten

zijn op dezelfde plek gezet. Dit betekent dat ze niet allemaal zichtbaar zijn.

Objecten die in de Scene geplaatst zijn, kunnen worden aangepast. Om een object aan te passen, selecteer
je deze in de Hierarchy door op de naam te klikken of in de Scene zelf op het object te klikken. Wanneer je
een object selecteert, dan zie je dat er in het scherm rechts van de Scene informatie komt over dit object.
Dit scherm heet de Inspector en hier kan je alle informatie vinden over het geselecteerde object en deze

aanpassen.
" @ Inspector
¥ [Cube | [] Static ¥

Tag |Untagged ¢ Layer |Defaur ]

68 Mesh

¥ Materials

¥ Additional Settings

None (Pl

(]

Default-Material %,

> Shader | Standard -]

De Inspector.



INTRODUCTIE UNITY

De Inspector geeft alle informatie over een object. De naam, Tag en Layer zijn altijd bovenaan in de Inspector
te zien. Een Tag kan gebruikt worden om meerdere objecten in een groep te stoppen. Die wordt gebruikt
wanneer deze objecten aangeroepen moeten worden via code.

De Layer heeft te maken met hoe het object zichtbaar is en heeft met Rendering te maken.

Onder de Tag is de Transform te zien. Alle 3D- en 2D-objecten hebben een Transform. De Transform laat
de Position, Rotation en Scale van objecten zien.

De Position geeft aan waar het object staat in de Scene. Een Position kan positief of negatief zijn. De richting
van een negatieve Position is tegengesteld aan die van een positieve Position.

De Rotation geeft aan of het object gedraaid is. Rotation werkt per 360 graden maar kan ook meer dan 360
graden gedraaid worden. Wanneer de Rotation over de 360 graden gaat betekent het eigenlijk dat de rotatie
weer O is.

Als laatste is er de Scale. Scale geeft weer hoe vergroot het object is. Wanneer je de Scale van een object
naar 10 zet, zal het object tien keer zo groot zijn.

Onder de Transform zijn een aantal andere Components te zien. Deze Components worden toegevoegd
door Unity wanneer een object is geplaatst. Components kunnen ook toegevoegd worden door middel
van het Add Component-knopje.

Components zijn onderdelen die Unity zelf biedt met allemaal soorten functionaliteiten. Deze Components
worden veel gebruikt tijldens het maken van spellen, omdat het de basisfunctionaliteiten zoals zwaartekracht
kunnen bieden. Ook hebben 3D-objecten Materials. Een Material is een kleur of textuur die op een object
gezet kan worden. Wanneer een object een Material heeft, zal deze de kleur hebben van de Material.

Als een object is geselecteerd zullen er in de Scene drie gekleurde pijlen uit het object komen. Als het object
is geselecteerd en je ziet de pijlen niet, druk dan op W. Deze gekleurde pijlen kunnen gebruikt worden om
de positie van het object te veranderen.

ol LT E Il Objecten verplaatsen

Probeer nu je object te verplaatsen. Zoals je ziet zal er in de Inspector informatie veranderen. De Position
van het object is veranderd. Objecten hebben drie verschillende aspecten. De Position geeft de positie van
het object in de Scene aan, de Rotation bevat informatie over hoeveel het object gedraaid staat en de Scale
gaat over hoe groot het object is.

Zet je eerder gemaakte objecten op een rij.

3 Scene.

3D-objecten op een rij.

10



INTRODUCTIE UNITY

THEORIEBRON TABBLAD GAME EN ASSET-FOLDER

Boven het Scene-scherm heb je het tabblad Game. Wanneer je deze selecteert zie je wat de speler zou zien
als de game is opgestart. Voor ons zullen dat alleen de objecten zijn, maar het game-tabje is heel handig
om te testen of je game overeenkomt met wat je in de scene hebt gedaan.

Wanneer je een object hebt gemaakt biedt Unity je de mogelijkheid om deze op te slaan zodat je deze vaker
kan gebruiken, bijvoorbeeld een muur die je meerdere keren wilt plaatsen. Dit kan je onderin het Scene-scherm
doen. Hier zie je dat er al een folder bestaat met de naam Scenes. Alle bestanden die jouw project bevat
heten Assets. Je kan een object aan jouw Assets toevoegen door deze te selecteren en dan in het
Assets-scherm te slepen. Dit proces maakt een Prefab. Een Prefab is niets anders dan een opgeslagen object
dat alle informatie bevat van het object dat is opgeslagen. Prefabs worden gebruikt om een object meerdere
keren toe te voegen aan een Scene of om een Scene dynamisch op te bouwen door middel van Scripts.

@ Project | []Consol .

| create ~| @ ) |& [N * 9]

v | /Favorites  Assets
©\ All In Progr
©\ All Modified P P ()
©\ All Conflicts Z
©L All Excludec “
© All Materiale
@AII Models Audio Materials Prefabs Scenes Scripts TextMesh P.. PhysicsMa...
©\ All Prefabs

Audio
Materials
(Gl Prefabs
& Scenes
& Scripts
» Gl TextMesh P
» il Packages

De Asset-folder.

(oL b iV L) B0 Fen prefab maken

Maak een Prefab van de Cube die in de Scene staat.
Maak een nieuwe folder in je Assets (druk op rechtermuisknop en dan Create).
Open deze folder en sleep de Cube vanuit de Hierarchy in het Assets-scherm.

Geef de Cube een naam.

Test jezelt

Wat gebruik je in Unity om een spel te maken?

Waar kan je alle componenten in de Scene vinden?

Waar kan je de informatie zien van een geselecteerd component?
Wat zit er standaard in een Scene als je deze maakt?

Wat bevat de Transform van een object?

1



INTRODUCTIE UNITY
f.  Waar kan je een Prefab voor gebruiken?
g. Hoe verplaats je een object?

h. Hoe maak je een Prefab?

12



In dit hoofdstuk leer je om een poppetje te laten bewegen. Dit doe je door met Components te werken en
een Script toe te voegen aan een poppetje. Het eerste wat je daarvoor moet doen is een Unity Package
downloaden. Een Unity Package bestaat uit een aantal Assets die je direct in Unity kan gebruiken.

Video-uitleg

Bekijk de video over beweging in Unity.

(ol LV N ) Rl Unity package dowloaden

Download de Unity Package en importeer deze in Unity.
Wanneer je de package gedownload hebt, ga naar je Assets in Unity en klik je de op de rechtermuisknop.
Selecteer dan Import Package en kies voor Custom Package. Navigeer dan naar de folder waar de Unity

Package gedownload is en voer deze uit.

Klik dan op Import. De bestanden die uit de Package gehaald worden zullen in de Assets-folder staan.

THEORIEBRON DE PLAYER

Ten eerste is er een Scene geimporteerd. Wanneer je deze Scene opent zal er een aantal objecten in de
Scene staan. Een van deze objecten is de Player. De Player bestaat uit Unity 3D Objects en heeft ook een
Camera die hem volgt.

Om een Scene te testen in Unity kun je op Play drukken. Wanneer de Play-button is ingedrukt zal Unity
switchen naar het Game-scherm. Het Game-scherm geeft het beeld van de Camera weer.

Ook zijn er twee Scripts geimporteerd. Deze Scripts bestaan uit C#-code. Scripts kunnen objecten aanspreken
en functies uitvoeren. De geimporteerde Scripts zorgen ervoor dat een speler kan bewegen en er van Scene
veranderd kan worden. Scripts kunnen alleen iets uitvoeren wanneer ze als Component op een object
geplaatst worden.

13



MOVEMENT

Import Unity Package n

UnityLesbrief

Een Unity Package.

oLV NeL L'l Movement Controller Script

Geef de Player het Movement Controller Script. Dit kan je doen door de Player te selecteren in de Hierarchy
en dan in de Inspector naar beneden te scrollen totdat de knop Add Component in het scherm komt. Druk
dan op Add Component en zoek naar Movement Controller.

a. Selecteer de Player in de Hierarchy.
b. Klik op Add Component.
c. Zoek naar Movement Controller en selecteer deze.

Als de Player de Movement Controller heeft, kan de Player nu door de Scene bewegen. Je doet dit door op
Play te drukken en dan met de WASD-toetsen rond te lopen. Ook kan je met de spatiebalk springen.

Q. Movement Controlle

z Movement Controller

De zoekfunctie bij Add Component.

14



MOVEMENT

THEORIEBRON MOVEMENT CONTROLLER

Wanneer een Script als Component op een object is gezet kan deze informatie weergeven. De Movement
Controller zal dan ook meerdere variabelen afbeelden. Deze variabelen kunnen aangepast worden en dit
zal de beweging van de speler veranderen.

Wanneer de Speed wordt aangepast zal de speler sneller of langzamer bewegen. Jump Speed zal de hoogte
van de sprongen bepalen, maar Gravity speelt daar ook een rol in. De Rotate Speed bepaalt hoe snel de
speler rond kan kijken.

Scripts bieden dus de mogelijkheid om de gebruiker de optie te geven om de variabelen aan te passen
zonder zelf het Script in te gaan.

v « ¥ Movement Controller (Script) @ = %
Script MovementController (o]
Speed 6 |
Jump Speed |8 |
Gravity 120 |
Rotate Speed 3 |

Het Movement Controller Script.

De Movement Controller bestuurt een ander component, de Character Controller. Dit component is van
Unity zelf en wordt gebruikt om movement makkelijk te maken zonder een hoop berekeningen en moeite
te doen met physics. Net als de Movement Controller, heeft de Character Controller een aantal variabelen.

v & ¥ Character Controller @ = &,
Slope Limit 45 |
Step Offset 0.3 |
Skin Width 10.08 |
Min Move Distance  0.001 |
Center X 0 Y -1 1zo |
Radius 0.5 ]
Height 3 |

De standaardopties van een Character Controller
Component.

(oLl (e L Il Components variabelen aanpassen

Probeer de variabelen van beide components te veranderen. Sommige variabelen zullen de beweging van
de speler erg beinvloeden, maar andere variabelen zullen alleen de Player zelf beinvloeden.

15



MOVEMENT

THEORIEBRON RIGIDBODY

Naast de Character Controller is er nog een ander Component waar Movement mee geregeld kan worden.
Dit Component is de Rigidbody en deze heeft een aantal unieke functies. De Rigidbody wordt namelijk
beinvloed door de Physics Engine in Unity. Dit betekent dat een object met het Rigidbody Component
zwaartekracht zal hebben en met andere Rigidbodies kan communiceren, waardoor het object met de
Rigidbody andere objecten met een Rigidbody kan bewegen door ertegen aan te lopen.

v % Rigidbody e
Mass 1 |
Drag 0 |
Angular Drag 10.05 |
Use Gravity ™4
Is Kinematic J
Interpolate | None sl
Collision Detection | Discrete sl

¥ Constraints
Freeze Position Ox Oy Oz
Freeze Rotation Ox Oy Oz
» Info

Het Rigidbody Component.

In dit hoofdstuk ga je verder niet met Rigidbodies werken, omdat deze onderdeel zijn van de Physics Engine
van Unity. De Physics in Unity zal in een ander hoofdstuk besproken worden.

In de Scene MovementRigidBody zul je een Player-object vinden met een Rigidbody Component, een
Capsule Collider en het 'Move Rigid Body'-script. Deze drie Components zorgen ervoor dat de Player door
de Scene kan bewegen.

(ol VN ) Nl Nog meer variabelen aanpassen

Doe nu hetzelfde als je met het Movement Controller Script hebt gedaan. Pas de in de Rigid body variabelen
aan en kijk hoe dat de Player beinvloedt.

THEORIEBRON MOVE RIGID BODY

Het 'Move Rigid Body'-script heeft meerdere variabelen. Je kan door deze aan of uit te zetten bepalen of de
speler mag springen of niet en de maximale verandering in snelheid bepalen.

v « ¥ Move Rigid Body (Script) @ = %
Script MoveRigidBody (o]
Speed 6 |
Gravity 110 |
Max Velocity Change 10 |
Can Jump
Jump Height |2 |
Rotate Speed |2 ]

Het ‘Move Rigid Body'-Script.
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